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Summary 
This document is intended to serve as a set of instructions to assist the organization in the 

installation of the Chatbot Solution. The intended use of the solution is to provide a Chatbot on 

your website with a set of pre-configured Topics that allow visitors to your website to obtain 

instant information about a variety of subjects that you determine.  In addition to this, the 

solution also allows for a live “handoff” from the Chatbot experience to a Chat experience with 

a live human, if the organization wishes to deploy this feature. This handoff and subsequent 

chat experience are supported by the Microsoft project Omnichannel for Customer Service.  

Please follow the steps below to install the solution and then perform the configuration to 

enable the Chatbot on your website. 

Prerequisites 
The following components must be obtained prior to installing the solution: 

◼ Microsoft Dynamics 365 Customer Service Enterprise. At least one license is required. 

◼ Omnichannel for Customer Service. This suite of capabilities is a platform that must be 

present in the Microsoft Tenant of the organization that will install this solution. 

◼ Digital Messaging for Customer Service.  

 

 

 

 

The following components will need to be licensed1 after the installation of the Chatbot 

Solution and before the Trial expires: 

◼ Virtual Agent for Customer Service 

◼ Omnichannel for Customer Service 

◼ Digital Messaging for Customer Service 

  

 
1 The method of obtaining licenses from Microsoft for these products may differ from organization to organization. 
For more information about obtaining licenses through PartnerSource, please visit this page. 

NOTE: This guide makes use of the Trial method of obtaining Omnichannel and Digital 

Messaging. If your organization already happens to have both Omnichannel and Digital 

Messaging for your instance of Microsoft Dynamics 365 Customer Service Enterprise, then 

you can skip the section of obtaining these components using the Trial method. 

https://www.partnersource-it.com/


 

Steps for Installation 
The following steps should be followed in order to prepare the tenant for the installation and 

configuration of the solution:  

1. Obtain Microsoft Dynamics 365 Service – Enterprise edition 

2. Obtain Omnichannel for Microsoft Dynamics 365 Customer Service 

3. Obtain Free Power BI 

4. Confirm the Environment in Power Apps 

5. Obtain the Power Virtual Agent Trial 

6. Install the Solution 

7. Configure the Chatbot Topics 

8. Configure Omnichannel for Handoff 

9. Publish the Chatbot to your website or locally for testing 

  

Obtain Microsoft Dynamics 365 Service – Enterprise Edition2 
1. Visit the Microsoft Trials page 

2. Select the “Dynamics 365 Customer Service Tile” so that it is outlined in blue as shown 

below. 

  

3. Add your “Work email” address at the bottom of the page, and your phone number. 

4. Click “Get Started” as shown below 

 

 
2 Skip this step if you already have Microsoft Dynamics 365 Customer Service Enterprise 

Be sure this is selected before 

adding your email address at the 

bottom of the page. 

NOTE: You cannot use an email address from a free public service like Gmail, or 

Outlook.com, or any other public email address service. It should be a domain that you have 

control over.  You should also note that if the domain you use already has a subscription 

with Dynamics, you may need to contact your administrator to obtain the trial. 

https://trials.dynamics.com/


 

5. Follow the instructions until the instance is provisioned. When completed you will be 

able to log into office.com with the credentials you set up. 

Obtain Omnichannel 
Once you have installed Microsoft Dynamics 365 Customer Service Enterprise, you will be able 

to obtain Omnichannel for Customer Service.  However, the way in which you have procured 

Customer Service will dictate how you will obtain this add-on.  The most efficient way to 

determine how to obtain Omnichannel is to log into office.com with a Global Administrator 

account and look for the “Digital Messaging Add-In” in your administration portal.  

1. Visit Office.com.  

2. Lick “Sign In” in the upper-right corner of the browser. 

3. Use the credentials for the tenant where you have Microsoft Dynamics 365 Customer 

Service Enterprise installed3. You should see a screen similar to the one shown in figure 

1 below. Enter your email address, click Next and then your password. 

 

 

 

 

 

Figure 1 – Log in page for office.com 

(Please note that if this is the first time you will log in, your organization may require you to 

either change your password, set up additional authentication methods, or both.  If required, 

complete those prior to moving to the next step.) 

4. Once you have logged in, click the waffle at the top left and then choose “Admin.” 

5. Once in the Admin center, choose “Billing” and “Purchase Services” as shown below. 

 

 
3 If you have trouble obtaining licenses or need more licensing information, please see this page. 

NOTE: You must be a Global Administrator  in to follow these steps. If your account is not a 

Global Administrator account, please contact your Global Administrator for your tenant and 

ask for those permissions. 

https://www.office.com/
https://www.partnersource-it.com/


 

6. Scroll down to “Other Categories that might interest you” and choose the “Add-Ons” 

link. 

7. Scroll down under “Purchase Services” and look for “Dynamics 365 Customer Service 

Digital Messaging add-on Trial” as shown below. 

 

8. If you see this tile, click View Details, then click “Get Free Trial”. (If you do not see this 

tile, please proceed to step 10.  

9. Follow the instructions to obtain the trial.  

10. While logged in as a Global Administrator, open a new tab for Microsoft Trials. 

11. Choose Customer Service. 

12. Add the same email address that you used when logging into the office.com during this 

same session. 

13. Click “Get Started.” 

14. At the “You Have an Account with Us” dialog box, click “Sign In.” 

15. You should then see a notice like shown below. 

 

16. Click “OK, got it” to proceed. (You may see “Setting Up” for a few moments.) 

17.  When the screen refreshes, you should see the following two tiles for Omnichannel: 

    

Depending on how you obtained 

Microsoft Dynamics 365 Enterprise you 

may or may not see this tile. If you do 

not see this tile, proceed to step 10. 

https://trials.dynamics.com/


 

18. Once you have confirmed that these two tiles appear, proceed to obtain a Free Power BI 

subscription. 

Obtain Free Power BI 
Follow the instructions below to obtain a Free Power BI subscription. 

1. Log into office.com as a Global Administrator 

2. Click Admin. 

3. Choose Billing and Purchase Services 

4. Scroll down to “Power BI” as shown below. 

 
5. Click “Details” under Power BI (free) as shown below. 

 

6. Click “Get Now” as shown below. 

 

7. Follow the instructions to obtain the Power BI license. (Be sure to leave selected 

“Automatically Assign licenses to all users”) 

Confirm the Environment 
The next step is to confirm the environment that has Omnichannel, since you will need to know 

which environment to work in for the remaining steps of this document. Follow the steps below 

to confirm the environment.  



 

1. While logged into office.com as Global Administrator, click on Admin on the left. 

2. Click “Show All” on the left as shown below. 

 

3. Scroll down on the left and click “All admin centers” as shown below. 

 

4. Click “Power Apps” as shown below. 

 

5. Click on “Environments” on the left side of the screen as shown below. 

 

6. Under Environments in the main screen, you should see a list of at least one 

environment. If you used the trial method, you should see an environment with type 

“Trial (30 days).” An example is shown below.  YOU WILL SEE A DIFFERENT NAME – THIS 

IS JUST AN EXAMPLE: 

 

 
Example of the environments section of Power Platform Admin  

7. Select the Trial instance and click the ellipses as shown below. 

 



 

8. With the ellipses selected, choose “Resources” and then “Dynamics 365 apps” as shown 

below. 

 

9. When the screen refreshes, look for a set of Omnichannel apps with a status of 

“Installed” as shown below. 

 

10. If you do not see a status of “Installed” and see a different status, such as “Not 

Configured”, please contact us. 

Obtain Power Virtual Agent (Trial) 
The next step is to obtain the Power Virtual Agent service. This is most easily accomplished by 

using the trial method. Please follow the instructions below to use this method. 

1. Log into office.com as a Global Administrator. (Very important to log in with the same 

credentials as previously.) 

2. Open a new tab and visit the Power Virtual Signup Page4. 

3. Use the SAME EMAIL address that you are using as Global Administrator in step 1 above, 

and then click “Sign Up” as shown below. 

 

4. You should see an “Almost there” screen as shown below. 

 
4 NOTE – If the link in this document has changed, please visit https://docs.microsoft.com/en-us/power-virtual-
agents/sign-up-individual and click the link where it reads “Go to the sign-up page.”  

https://partnersource-it.com/contact
https://go.microosft.com/fwlink/?LinkId=2107702
https://docs.microsoft.com/en-us/power-virtual-agents/sign-up-individual
https://docs.microsoft.com/en-us/power-virtual-agents/sign-up-individual


 

  
5. You can optionally check the “I would like ..” box and then click Create as shown above. 

6. Wait about a minute or two and then choose a country and click “Get Started” as shown 

below. 

 

7. On the next screen, add a name for the default bot, choose a language and be sure to 

choose the environment where you have confirmed the Omnichannel installation in 

previous steps.  An example of this choice is shown below. Please note we are NOT 

choosing the “Default” environment – we are choosing the environment that we have 

confirmed that Omnichannel is installed in. 



 

 

Example of choosing the correct environment while configuring Power VA 

8. Click “Create” as shown above. 

9. Wait several minutes (up to five or six minutes) until the process is completed. 

10. Now visit https://go.microsoft.com/fwlinbk/p/?linkid=20709032.  

11. In the screen that shows up, click “Consent on behalf of your organization” and click 

“Accept” as shown below. 

 

This is a necessary step to 

authorize the Omnichannel for 

specific permissions in your 

tenant.  

Failure to perform this step will 

prevent the handoff from the 

Power Virtual Agent to 

Omnichannel. 

You must be logged in as a Global 

Administrator to complete this 

important step. 

https://go.microsoft.com/fwlinbk/p/?linkid=20709032


 

 

Install the Power Virtual Agent Solution 
Follow the instructions to obtain and install the Power Virtual Agent Chatbot Solution. 

1. First, download the agent solution file here. Save this file to your computer. 

2. Then download the scheduling solution file here. Save this file to your computer. 

3. Log into office.com as a Global Administrator. 

4. Open a new tab and visit https://powerva.microsoft.com 

5. Click the small gear icon to the top right of the screen and choose General Settings as 

shown below. 

 

6. On the screen that appears, click the “Go to Power Apps Solutions” link as shown below. 

 

7. At the top of the page, click “Import” as shown below. 

 

https://partnersource-it.com/placeholder
https://partnersource-it.com/placeholder
https://powerva.microsoft.com/


 

8. When the “Import a Solution” dialog appears, click “Browse” to locate the “VanillaBot” 

solution file. Please choose the VanillaBot solution file before choosing the Scheduling 

solution file. 

9. Click “Open” when the file is chosen in your file manager. 

10. Before you click “Next” ensure that the file is selected as shown below5. 

 

 
11. Click “Next” and then click “Import” as shown below. 

 

12. Wait several minutes until the import is complete. You will know the solution has 

completed by a notification at the top of the screen as shown below. 

 

13. Repeat the same process to install the second file provided from PartnerSource-IT, which 

is named “Workforce Agent Hours.” 

 
5 Please note that you will be installing the “managed” version, so your file name might be slightly different. 



 

14. Once both solutions are imported, it’s a good idea to click “Publish all Customizations” at 

the top of the screen as shown below. 

 

Renaming your Bot 

At this point you may wish to rename the chatbot that you have just installed. Follow the steps 

below to do so. 

1. From within the Power Apps, Solutions screen (essentially where you left off after 

importing the solutions described above), click “Chatbots” on the left side navigation 

and choose “List” as shown below 

 

2. Click on the “sdworkforce-bot” link as shown below to open up the newly imported 

chatbot. 

 

3. When the bot screen opens, click “Manage” and then “Details” as shown below. 

 



 

4. In the screen below, you can change the name of the bot as well as the icon.   

 

5. Click “Save” at the top of the screen once you are done with your changes. 

6. Please note that this is the same screen where you will configure your Topics, which is a 

series of steps described next. 

Topics Configuration 
Now that the solution is installed, it’s important to complete the task of configuring the 

provided topics to work with your organization.  The series of sections below will walk you 

through this process. 

Topics Overview 
“Topics” can be thought of as discrete chat subjects which can have a dynamic component, 

such that the chatbot will interact with human visitors according to a logical tree with branches 

as leaves.  This is referred to as the “conversation path.”  

The most important and potentially time-consuming part of the installation is the configuration 

of the 70+ “User” topics that come pre-configured with the solution. One thing to remember to 

mitigate how daunting this task may be is that in all likelihood your organization may not need 

to make use of all provided topics.  In actuality, you may only need to work with a subset of the 

provided topics. 

There are two types of topics: 



 

◼ User Topics – these are organization-specific topics which you will need to decide upon 

and configure according to what your organization offers and wishes to convey to 

visitors. There are more than 70 User topics included in the solution. 

◼ System Topics – these are topics used by the system in order to facilitate the operation 

of the chatbot itself.  Examples include “Greeting”, “Start Over”, “End of Conversation” 

and “Escalate.”  You can also configure these, but your configurations for these types of 

topics will likely be operational in nature.  

Topics are comprised of three main components: 

◼ Trigger Phrases – these are phrases that you would expect your visitors to use in order 

to obtain information about the topic. You can add as many as you feel are appropriate 

for a given topic. If a visitors types one of the phrases in the chat window, the first  

Message in the conversation path will be presented. 

◼ Message Nodes – a message node is what will be presented to the visitor in response to 

their visit ( as a greeting, if you have a greeting set up), or during a conversation path 

with the chatbot. Message nodes have several potential uses: 

o Asking a question 

o Calling an action (like another topic) 

o Showing an informational message 

o Ending the conversation 

◼ Actions.  Actions refer to an outcome of a decision tree in the conversation path which 

may lead to something like a redirect to another topic, or the end of the conversation, 

as examples. 

The scope of this document is to help you work with the existing topics that are included in the 

chatbot solution provided. To create and manage new topics, there is robust documentation 

from Microsoft found here. 

Topics Strategy 
We believe that the most efficient way in which you can approach the configuration of topics in 

the solution is to follow these steps: 

1. Examine each topic for relevancy to your organization.  Choose a disposition for each 

topic: 

a. Not relevant at all.  In this case you would likely disable the topic. 

b. Relevant, but needs logical modification. In this case, the topic itself is relevant, 

but you would need to re-arrange the conversation path by potentially dropping 

branches or re-routing the conversation path. 

c. Relevant, but needs light modification. “Light modification” can be defined as 

inserting a relevant URL or adding your organization name to the dialog 

message. 

d. Relevant and needs no modification. 

https://docs.microsoft.com/en-us/power-virtual-agents/authoring-create-edit-topics


 

2. Once you have recorded your disposition of each of the topics, then disable the topics 

that correspond to item “a” above – that is, no relevancy at all to your organization. 

 

3. Once you have disabled the topics you will not be using or modifying, you can then 

proceed to edit each remaining topic according to your organization needs and 

conversation design.  Below is provide some examples of how to edit topics to suit your 

organization. 

Topic Modification  
You can perform the following changes to a topic you have decided to remain active and will 

not be disabled: 

1. Disable a topic. 

2. Add, remove, or change trigger phrases. 

3. Change message content 

4. Modify question choices for visitors 

5. Call other topics or remove actions that call disabled topics 

6. Add new actions 

The following examples cover most of these6: 

Disabling a Topic 

Disabling a topic is a simple matter of “turning it off” as shown below, by clicking the “Status” 

field from “On” to “Off” for a given topic. 

 

 

 
6 The scope of this document does not include the addition of new actions.  Microsoft provides helpful 
documentation for this subject here.  

NOTE: It’s very important when you disable a topic to ensure that no other enabled topics 

reference the disabled topic.  Because in some cases the result of a conversation path is an 

action to call another topic, you must make sure you are not calling a disabled topic, or you 

will get an error and your chatbot will not functional properly.  

Simply click this icon 

for any given topic 

to disable it. 

https://docs.microsoft.com/en-us/power-virtual-agents/authoring-create-edit-topics


 

Adding or Changing a Trigger Phrase 

1. Click on “Authoring Canvas” icon for a given topic as shown below. 

 

2. Click the vertical ellipses as shown below 

 
3. In the Setup tab you can click on an existing topic to edit that topic, or you can simply 

click in the “Enter a Trigger Phrase” field and click Add to add the phrase to the list.  

4. Click “Save topic” in the upper right when your changes are completed. 

Changing Message Content 

To change message content, simply click in the message node you wish to change and select 

the text you wish to change and type new text. Or you can delete and replace text.  Below is an 

example. 



 

 

Click “Save” at the top right of the screen when you are done making changes as shown below. 

 

Modifying Question Choices for Visitors 

In some of the included topics you will find conversation paths that make use of questions 

posed to the visitor, which will then lead the visitor to messages down a relevant branch of the 

conversation path, or it may lead to other topics.  

To make changes to the questions themselves, you would change the “Condition” node.  An 

example is below. 

Click into the message node, 

select any text you wish to change 

and type over your selection. 

 

You can also select an existing link 

and click the “link” icon to change 

the URL. 

 



 

 

A question about age with conditions 

In the screen shot above, you can see that the chatbot is asking a question of the visitor – 

“please tell us your age.”  

The three conditions are as follows: 

◼ Greater than or equal to 25 

◼ Less than 18 

◼ All other conditions (essentially 18-24) 

Each of these conditions will lead to specific messages and potentially other topics. 

However, you can make changes to these conditions simply by interacting with them. For 

instance, you can change the value “25” by clicking the ellipses for the node and making the 

appropriate change.  

Changing Multiple Choice Options 

Throughout the provided topics you will notice that there are many examples of multiple 

choices that are presented to visitors. You are able to make changes to these choices as shown 

in the example below. 



 

 

Calling other Topics  

As you can see below, a response such as “youthAndAdultChoices” can be used in one or more 

conditions that can drive the path forward and redirect the user to another topic.   

 

In this case, the logic is fairly straightforward, such as “If the response is Tutoring & guidance 

counseling, then Redirect the user to the Youth topic.”  This has the effect of calling the 

greeting from the topic named “Youth.” 

This is an example of the ability to 

modify existing multiple choice 

questions.  

First, you would modify the text 

under “Ask a question” to conform 

to whatever changes you decided 

to make. 

Once you make your changes to 

the text, then you could modify 

the “Options for user” as shown.  

You can remove, change, or add 

new options. 

In this example, the response is 

stored as “youthAndAdultChoices” 

which may be referenced in a 

condition later in the path. 



 

Omnichannel Configuration 
Omnichannel from Microsoft in the context of the Power Virtual Agent solution is an add-on 

component in the Dynamics 365 platform that provides one or more channels to “hand off” the 

conversation between a virtual agent (chatbot) and a human visitor to a human agent.  

This document provides the steps to configure Omnichannel to seamlessly hand off the 

conversation with a human agent using the chat experience.  It should be understood that 

other channels besides chat are also available, such as text messaging, Microsoft Teams, and 

others. More information regarding the configuration of other channels is found here, or you 

can also contact PartnerSource IT for more information as well. 

Promote Omnichannel User to Admin 
This step is preliminary in the event that this is a new Dynamics installation and the user who is 

configuring Omnichannel has not yet been promoted to an Administrator. If this step has 

already been performed in another context, this step is not necessary.  

1. Log into office.com with a role of Global Administrator. 

2. Click the “Admin” icon on the left part of the navigation. 

3. Click “Show All” on the left as shown below. 

 

4. Scroll down on the left and click “All admin centers” as shown below. 

 

5. Click “Power Apps” as shown below. 

 

6. Click on “Environments” on the left side of the screen as shown below. 

 

https://docs.microsoft.com/en-us/dynamics365/omnichannel/administrator/channels


 

7. Under Environments in the main screen, you should see a list of at least one 

environment. If you used the trial method, you should see an environment with type 

“Trial (30 days).” An example is shown below.  YOU WILL SEE A DIFFERENT NAME – THIS 

IS JUST AN EXAMPLE: 

 

 
Example of the environments section of Power Platform Admin  

8. Select the instance that contains Omnichannel and click the ellipses and then “Open 

Environment” as shown below. 

 

9. When the environment loads, click the small gear icon in the upper right corner as 

shown below. 

 

10. Click “Advanced Settings” as shown below. 

 



 

11. Click Settings, and then Security as shown below. 

 

12. Click the “Users” icon. 

13. If “Full Access Users” does not appear by default, use the view selector to change to that 

view as shown below. 

 

14. Once you have selected the view, select the user (click the small checkbox next to the 

name) who will configure Omnichannel and click “Promote to Admin” as shown below. 

Use the “view selector” drop-

down arrow to find and select 

“Full Access Users” 



 

 

15. Click “OK” to confirm once the confirmation dialog appears in the upper left side of the 

screen. 

16. With the user still selected, click “Manage Roles” as shown. 

 
 

17. When the “Manage User Roles” dialog appears, scroll down to find all Omnichannel 

roles and select them for the user you are managing as shown below. 

 

18. Click “OK” when the roles are selected. 



 

Connect Omnichannel to Power Virtual Agent 
Once the user who will be working in the environment to configure Omnichannel has been 

promoted to Admin in the environment, and also provided with the correct security roles, 

Omnichannel can now be connected to Power Virtual Agent. 

The following steps should be followed to achieve this objective. 

1. From the same browser session, and logged in as a Global Administrator, and the user 

who has been provided the permissions, open a new tab to 

https://powerva.microsoft.com. 

2. In the upper right corner, click the small gear icon, and then choose “Transfer to Agent” 

as shown below. 

 

3. Click the “Dynamics 365 Omnichannel for Customer Service” icon as shown below7. 

 

4. Click “Next” on the screen that follows. 

 
7 NOTE – if you do not see this icon, it means you may have missed a step – particularly step 11 of the “Obtain 
Power Virtual Agent” section above. 

https://powerva.microsoft.com/


 

5. Follow the steps in the “Enter Power Virtual Agents Application ID” dialog box that 

appears, which is shown below. 

NOTE: completing this part of the installation requires access to Microsoft Azure. This may 

require Azure registration, which is outside of the scope of this document. Please feel free to 

contact PartnerSource IT for assistance if necessary.  

 

6. Once you have the Power Virtual Agents Application ID entered into the screen that is 

shown above, click “Next.8”  

7.  Click Next at the following screen. 

8. When the “Choose an environment” screen appears, be sure to select the correct 

environment which contains Omnichannel and the Power Virtual Agent solution. (This 

may be a trial environment) as shown below. 

 

9. Wait a small amount of time (less than a minute or two) while the Connection 

completes.  Once the connection has completed, you should see a notice like shown 

below.

 

 
8 If you need help with this step, please see minute 4:00  in the supplied support video named “4-Omnichannel-
Configuration.” 

IMPORTANT – please note that 

this is an EXAMPLE environment 

for purposes of illustration.  

You should select your own 

environment which contains the 

Omnichannel solution installed. 



 

 

Configure Omnichannel for Handoff to Human Agent 
Please follow the steps below to configure Omnichannel to hand off a conversation to a live 

human agent using Omnichannel. 

1. Log into office.com as a Global Administrator. 

2. On the left side navigation, click the “Dynamics 365” icon as shown below. 

 

3. Click the “Omnichannel Administration” tile as shown below. 

 
4. When the screen loads, click on “Queues” in the lower left navigation as shown below.  

 

 

 

5. Click “+NEW” at the top of the screen as shown below. 

 
6. When you fill out the form that appears, you can use the following values: 

a. Name: “Bot Queue” 



 

b. Priority: 2147483647 

See below for an example: 

 
7. Click “Save” when completed as shown above. 

8. When the screen refreshes after the Save, click “Add Existing User” as shown below. 

 

 

9. Use the lookup field to search for “Virtual Agent”, which should be a user that was 

automatically created in previous steps by the system. 

 

 

NOTE: The “Virtual Agent” name will be in the format “Virtual Agent (the-name-of-your-

bot)”. Above is an example using a scenario where we re-named the bot to “myworkforce-

bot.” The name of your Virtual Agent may be slightly different.  

 



 

10. Click “Add” after selecting the Virtual Agent user.  

11. Once you have successfully added the Virtual Agent user, then select and remove the 

default user as shown below (the name below is an EXAMPLE.  Yours will be different.) 

 

The next task is to create the Live Agent (Human) Queue. 

12. Click “Queues” on the left navigation.  

13. Click “+NEW” at the top of the screen as shown below. 

 

 

14. When creating the Live Agent queue, make sure to use a lower number for the Priority 

field. If you used the value from the last step for the Bot Queue, you can use the values 

as shown below for the Live Agent queue.  

 
15. Click Save when completed as shown above. 



 

16. After clicking Save, when the screen refreshes, click “Add Existing User” as shown in step 

8 above. 

17. When the “Lookup Records” screen appears, select each user which will serve as a Live 

Agent from the list and click “Add” 

18. Click “Users” on the left navigation as shown below. 

 

19. In the list of Users that appears under the “Omnichannel Users” view, check each Live 

Agent user and ensure that their “Capacity” column is LESS than the value that appears 

for the Virtual Agent.  For instance, below, the Live Agent user has a capacity of 100, 

which is lower than the capacity for the Virtual Agent, which is set at 2,000,000,000.  

 

If any users have a capacity equal to or greater than the Virtual Agent, double-click on the user 

record, click on the “Omnichannel” tab and change the capacity to a lower number than the 

Virtual Agent as shown below. 

 

20. Click Save when making changes to any users. 

Configure Work Streams 

Follow the steps below to configure the Work Streams in Omnichannel. 



 

1. From Omnichannel Administration, click the “Work Streams” icon on the left 

navigation as shown below. 

 

2. Click the “Live chat workstream” as shown below. 

 

3. In the Live chat workstream form, “Work Distribution” tab, choose an appropriate 

value for “Auto-close after activity.”  This will dictate how long the chat window 

remains open when activity is not received by a human visitor in a chatbot session.  

Below is an example where we have chosen 15 minutes. 

 

4. Click the “Context Variables” tab as shown below. 

 



 

5. Click “+ NEW” as shown below. 

 

6. In the “Quick Create” form that appears, enter the following values as shown below. 

It’s very important to match the case of the txt in all Context Variables below. 

 

The values are: 

a. Display Name: Bot ID 

b. Name: BotId 

c. Type: Text 

7. Click “Save and Close” at the bottom when completed. 

8. Repeat step 5 to create a second Context Variable record. In this case, use the 

following values: 

a. Display Name: Name 

b. Name: Name 

c. Type: Text 

9. Click “Save and Close” at the bottom when completed. 

10. Repeat step 5 to create a second Context Variable record. In this case, use the 

following values: 

a. Display Name: va_Scope 

b. Name9: va_Scope 

c. Type: Text 

11. Click “Save and Close” at the bottom when completed. 

 
9 Be sure to match the case of this variable and all variables as shown in these steps. 



 

12. Back at the Live chat workstream form, confirm that your screen looks exactly  as 

the one shown below. 

 

13. Click the tab “Routing Rules” as shown below. 

 

14. Click “+ Add” on the right side of the screen as shown below. 

 

15. The first routing rule should be named “Bot Routing” with the chosen queue as “Bot 

Queue” as shown below.  Click “Save”. 

 



 

16. Once the record is saved, you can add a Condition. Click the “+ Condition” link to the 

right, and then choose “Context Variable” from the list of conditions, “va_Scope” 

from the list of attributes, and “Does Not Contain Data” as an operator.  See below 

for a screen shot of this configuration.  You can optionally include a Description like 

“This is for VA.” 

 

17. Click “Save” once you have created this condition.  The next steps will walk you 

through the creation of a routing rule for the Live Agent. 

18. Click the “Live chat workstream” link to get back to the Work Stream quickly as 

shown below. 

 

19. Click the “Routing Rules” tab. To see an example, see step 13 above. 

20. Click “+ NEW” for the second rule. 

21. Use the following values: 

a. Name = “Live Agent Routing” 

b. Queue = Live Agent Queue 

c. Description (optional) = “ To transfer to Humans” 

22. Click “Save” 

23. Click “+ Condition” to add the condition for the Live Agent Routing Rule. 

24. In this case the values are “Context Variable”, “vaScope” “Equals” “bot.” 

An example of this condition is shown below. Be sure to click “Save” when completed. 



 

 

25. Click “Save” in the upper left corner of the screen to save the routing rule. 

26. Return to the Routing Rules tab to confirm that your screen looks like the screen 

below. 

 

 

Configure Chat Widget 

1. Click on the “Chat” icon under “Channels” in the left navigation as shown below. 

 

2. Click “+NEW” as shown below. 

 



 

3. Name the Chat Widget and select a Language as shown below. 

 

4. Click Save in the upper left corner of the screen. 

5. In the windows that refreshes, scroll to the lower right of the screen and look for a 

“Code Snippet” as shown below: 

 

(Note that the ID for this snippet is obscured for privacy reasons_ 

6. Copy this code snippet onto a notepad instance or another text editor, since this is the 

code you will embed into either a website or even a local HTML file to test and deploy 

the chatbot. 

7. Optionally, you can use various tabs to configure elements of your chatbot widget. We 

will cover the Design tab, but you can configure the other options using information 

from this resource.  

8. To set the Design, click on the “Design” tab and make the following adjustments, as 

needed: 

a. Theme color – choose a color 

b. Title: edit the title of the widget as it will be seen when the chat widget first 

appears on the site. 

c. Subtitle: edit the text that will appear under the Title. 

See below an example of the Design tab in Omnichannel Chat Widget. 

https://docs.microsoft.com/en-us/dynamics365/omnichannel/administrator/set-up-chat-widget


 

 
9. Click “Save” in the upper left to save your design changes. 

Publish/Deploy the Chatbot 
There are a number of publishing steps that you can take, once you have configured 

Omnichannel. Each is useful according to the stage of deployment you are in: 

◼ Publish to the Demo Website.  This is the ability to publish your chat widget to the 

Power Virtual Agent public demonstration website. This allows you to test the basic 

configuration of the bot, as well as the conversational logic, without having to publish 

on a website, or even locally to a test HTML file. In this method, you do not need to 

make use of the code snippet referenced above.  This method is NOT intended for 

product or public use of Power Virtual Agent. It is merely for demonstrations.  

 

◼ Deploy to a local HTML file. In this method, you can embed your chatbot, using the code 

snippet referenced above (YOUR version, not the version shown in this document). This 

is a way to test the functionality of your chatbot as if it were on a public-facing website, 

but without having to actually deploy it to a public-facing website.  

 

◼ Deploy to a public-facing website.  You can use this method to deploy the chatbot using 

the code snippet either on a public-facing test website, or a public-facing production 

website. It should be understood that this method is essentially identical to the previous 

“local HTML file” method, since it simply involves adding the code snippet to any HTML 

page that you control. 

 



 

Publishing to the Demo Website 
To publish to the public demo website provided by the Power Virtual Agent service, follow 

these steps: (Remember that this is not intended for production – only for demonstration.) 

1. Log into office.com as Global Administrator 

2. Open a new tab for https://powerva.microsoft.com 

3. In the screen that appears, make sure you are working with your new workforce bot, 

and not the “default bot” that you obtained with Power VA, then click “Go to Publish” as 

shown below. 

 

4. Click the “Publish” button on the main screen that appears, and then “Publish” again in 

the small dialog that pops up as shown below. 

 

5. You may need to wait a minute or two while the bot publishes. 

https://powerva.microsoft.com/


 

6. Look for a notice like shown below to confirm your publishing success. 

 

7. If you see this notice you can try out the “Demo Website” by clicking the link shown 

below on the same page as the notice as shown below. 

 

 

NOTE: If clicking on this link results in an error, then wait up to 15 minutes as the notices 

suggests.  

Confirm the Demo Website 

When the bot has been successfully been published to the Demo Website, clicking on the link 

will reveal a page that looks like the one below.  In the demo,  you can greet the bot by typing 

“Hello” or some greeting as shown below. 

 



 

Typing “Hello” as shown above and clicking the small arrow to the right is how you test the 

chatbot.  The response should be something like shown below. 

 

 

Deploying to local HTML, a Test Website, or a Production Website 
As mentioned above, the method of deploying the chatbot to any website or HTML file is the 

same, since it consists of the simple step of adding the code snippet referenced above to any 

HTML file you control, whether it be a local HTML file on your computer, or one on a website. 

Follow these steps: 

1. Locate the code snippet you saved onto your computer from previous steps, or retrieve 

it from the Chat Widget entity form in Omnichannel as described above. 

2. Open the HTML file you wish to deploy the chatbot to, whether it be a local HTML file 

you create on your own computer10, or a website HTML file controlled by your 

organization.  

3. Paste the code snippet from the Chat Widget form in Omnichannel into your HTML 

page.  

4. Wait a moment for the widget to appear on the page (please note that for local HTML 

the widget may take up to a minute to load.) 

5. Interact with the chatbot with text or clicking multiple choices that are presented by the 

chatbot. 

 
10 Please see APPENDIX A for steps how to test your chatbot with a local HTML file. 

The screenshot to the left 

represents a test of the chatbot 

installed without any Topics 

configured. If you have configured 

your topics, then the greeting you 

have created/edited should 

appear with the prompt of 

“Hello.” 

It’s important to understand that 

when the chatbot is deployed to a 

HTML file or a website using the 

code snippet, that the greeting 

will automatically appear without 

a prompt unless you have 

configured it otherwise. 



 

Testing Omnichannel Handoff 
The configuration of Omnichannel above provides the ability for the chatbot to “hand off” the 

conversation to a live agent. To test this, follow the steps below. 

1. Log into office.com. 

2. Click the Dynamics 365 icon. 

3. Click the “Omnichannel for Customer Service” icon as shown below. 

 

4. To test this as one person, position the screen with half the screen occupying the 

Ominchannel for Customer Service screen, and then open the HTML file or website 

where the chatbot is deployed. An example is provided below. 

 

5. In the right-side, which is the interaction with the chatbot, initiate a transfer by typing 

the word “Agent” as shown above. 

6. Shortly after the chatbot informs the visitor that they are being transferred to a live 

agent, look on the left side of the screen for a notification regarding the transfer, an 

example of which is shown below. 

 

Example notification. 

The Omnichannel user should click 

“Accept” to begin live chat with the 

visitor inside of Omnichannel 



 

7. Carry on a conversation with the visitor from Omnichannel, playing both sides of the 

conversation. An example of the Omnichannel side is shown below, with annotations. 

 

 

Once the conversation is finished, the agent may end the conversation from within 

Omnichannel. 

 

Using Omnichannel For Customer Service 
A full treatment of Omnichannel for Customer Service is outside the scope of this document, 

but it should generally be understood that the data that appears in Omnichannel for Customer 

Service as a result of a Live Agent interaction is sharing the same Common Data set as Microsoft 

Dynamics 365 Customer Service.  

This means that all of the features of Dynamics 365 Customer Service such as dashboards, 

reporting and advanced find apply to the data that is stored in Omnichannel. It also means that 

it’s possible to show other service data, such as Cases or Service Requests, in the context of the 

Omnichannel information from chatbot or other channel interactions.  

History of the entire conversation 

is presented to the Live Agent. 

(Agent can scroll up to see full 

history) 

Salmon-colored chats are internal, 

not visible to the visitor. 

Public chats allow the Live Agent 

to interact. 

Live Agent can choose “Internal” 

to take notes not visible to visitor 



 

The screen shot below shows how a Case in Dynamics 365 Customer Service is displayed 

alongside customer interaction through the chatbot experience. 

 

Ultimately, your organization will choose how to use both Omnichannel and Dynamics 365 

Customer Service, but the interoperability and native integration of functions should be kept in 

mind as you plan your own deployment and use of Microsoft Dynamics 365 Customer Service, 

Omnichannel and Power Virtual Agent, which are the main components of this solution. 

 

  



 

Appendix A – Deploying the Chatbot Solution to local HTML 
This section walks through the steps of deploying the chatbot solution to a local HTML file.  This 

section is written for those with zero experience working with HTML files. 

1. Open your favorite text editor (Microsoft Notepad is fine.) 

2. Click “Save as” and change the file type to “All Files (*.*) 

3. Name your file as shown below. 

 

4. Click “Save” 

5. At the top of the file, enter the following: 

 

6. Place your cursor in between the two HTML lines. 

7. Copy and paste the code snippet in its entirety between these two lines. You should see 

something similar to what is shown below. 

 

8. Click “File → Save” 

9. Find the HTML file you created on your workstation (chatbot_test.html) 

10. Double-click the file to open it using a web browser. 

11. Wait several minutes for the chat widget to load.  The chat widget will have successfully 

been deployed if you see something like the screen shot below in the bottom right 

corner of your web page: 

 



 

12. Click on the “Let’s Chat” widget to see the following screen. Loading may take as much 

as 30 seconds. 

  

13. If your test is successful, you will see the greeting without having to greet the chatbot as 

shown above, after the chatbot loads. 

14. You can now interact with the chatbot from your local HTML file just as if you were 

using it on a public-facing website. 

 

 

 

 

 


